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Welcome to InsideBC

Welcome to our new portal. Once you login here, you can get directly to
myBanweb, Moodle and your student or employee email without having to login
again. You will also get customized content and messages based on your major,
status and other information we know about you.

What's Inside?

At some point in the future, almost all your interactions with the college will begin in

Login
Email ‘
Address:
Forgot Password?
How Do I?
... login?

You enter your college assigned email address and your
password is the PIN you use to get into myBanWeh. If that
doesn't work, please try using Account Manager to reset
your password.

... get to my online class?
You just login above, click on the "My Courses” tab and

then on the name of your course.

Quick Start Guides

e Course Studio for Instructors

e Cetting to Moodle
Support

Are you having any problems? If so, you can call our 24/7 help
desk at 877-382-3508 .

this portal and you will only have to login once to get to most of our sites.

Webmail

Now that you have an insideBC account, the easiest way to get to your
webmail is by logging into the portal and clicking on the Email icon in
the upper right hand corner.

SUSREEES. MyBanWeb

Anything you would have gone to myBanWeb for in the past can now be
done through the portal. Depending on what you want to do, the links.
will either be on the Student, Faculty, or Employee tab.

Moodle

You access all your Moodle courses through the portal now. All you
have to do is login, click on the link in the "My Courses” tab and click
4 the link for the appropriate course.

College -

Kern C

College District

1801 Panorama Drive -

Bakersfield, CA 93305 - 661 395 4011 v
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http://inside.bakersfieldcollege.edu/documents/GettingToMoodle.pdf

I registered for an Online Course...

Now what do | do?!?

> A course, is a course, is a course.
Regardless of the mode of delivery, the course content and workload is the same, Online offers flexibility, NOT
an “easier way” to take a course. BC transcripts do not reflect the mode of delivery, just the course. Unless
otherwise listed, BC’s Online classes are regular semester length courses. Start/end dates are listed in the
Schedule of Classes.

» | hear that online classes are easier. Is that true?
NO. The subject matter in an online class is just as difficult as a face to face course, but online classes require
students to use some skills that may not be used in a face to face class. “Drill down” to the survey and see if
you are ready for an online class: http://www.bakersfieldcollege.edu/distance learning/

» Why do | have to set up a college assighed e-mail?
“It's important that you check your college-assigned email for updates and communications from both the
College and your instructors. Make sure to check the email routinely, or forward the email to another account
to ensure you are receiving information.”

» Where is my Online class (Moodle) and how do | log into it?
NEW! > http://inside.bakersfieldcollege.edu

» How do | find out about books, exams, etc.?
Instructors will send a course syllabus that will list this information. However, you may not hear from your
instructor until the first day of class; it depends on the instructor as to when they send out their course infor-
mation. Check with BC’s bookstore for textbook information. http://bookstore.bakersfieldcollege.edu/home.aspx

What is a Waitlist (WL)? How can | tell if I'm still on the WL?
Go Online to BC’s website, www.bakersfieldcollege.edu and check the Class Schedule, Waitlist

» What is the difference between Hybrid and Online classes?
Note the location/site listing of the course in the Schedule of Classes. Hybrid classes require an On-campus
participation or Orientation; Online do not. If you missed the Orientation for a Hybrid class, directly contact the
instructor. “Drill down” to the web pages for Hybrid, from: http://www.bakersfieldcollege.edu/distance learning/

» When should | hear from my instructor?
The official first day of the semester.

» How do | reach my instructor?
Make sure that you’re using the correct contact information, and be sure to check you college generated email.
Instructors will only contact students using their college generated student Gmail account.

» But, | signed up for a class from:
“P” - Porterville College http://www.portervillecollege.edu/online courses/
“C” - Cerro Coso Community College http://cconline.cerrocoso.edu

» Where can | go to get help?
IF the subject if specific (i.e. Financial Aid), contact that department directly; for hybrid math courses,
call 395-4530/Math Lab, SS 140.
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Chapter 1

Online Classes [non-traditionally delivered classes]

What is an online class?

Online classes are just like traditional on-campus classes. The main differences are:
v" You can learn about your assignments and do your coursework at the time most convenient to you.
v" You will access the course information by logging onto the Internet
v You will communicate with your instructor and classmates virtually.

Who should take an online class?
?  Are you self-motivated?
? Do you like to figure things out on your own and work by yourself?
? Do you like the challenge of working with new technology?
?  Are you good at remembering deadlines without being reminded?

If you answered yes to the previous questions, then you would probably adapt well to the online classroom.
Take the Successful Online Skills Survey on page 7 to determine whether or not the online environment
compliments your learning style.

Does an online class transfer?

The information and assignments for an online class are the same as they are for the comparable on campus
class. Check the information listed in the current BC Catalog or with the Counseling Department, for clarify-
cation on transferability of course credits.

What are the costs? / How do | sign up?

Online classes cost the same amount as regular on-campus courses. Consult the most recent catalog and/or
schedule of classes for current fees. You follow the same procedures to register in an online class as you do
for a class offered on campus. You can register through the college Web site www.bakersfieldcollege.edu.

What computer skills do | need for an online class?
You don’t have to be a computer expert. You only need to know how to:
v' navigate the Internet
v'use email, including how to attach a file to an email message
v' download a program from the Internet and install it
v' do a search on the web
If you have trouble with any of the above, all of these skills are covered in this Survival guide. If you still
have problems, you should consider taking an introductory computer class.

What type of computer do | need?

A computer capable of running the most current version of a modern browser (IE, FireFox, Chrome*, Safari*,
etc.) in addition to requirements for any software instructors commonly use (i. e. MS Office, Adobe Acrobat)
NOTE: Moodle does not “play well” with *Safari nor *Chrome; Firefox is the best to use. Suggestion:
Adobe Reader and Microsoft Office

How can | connect to the Internet?
You must provide your own access to the Internet, or use open computer labs on the main BC campus, the
Delano Campus, or at a public library. WIFI “hot spots” are located around the main campus.

» After | register for my online class, what do | do?
Where is my Online class (Moodle) and how do I log into it?

NEW! > http:/iinside.bakersfieldcollege.edu e
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When does my online class begin?
Your class will begin on the first day of the semester. Online classes are NOT self-paced. BC’s online classes
are full semester length class and officially start the first day of the semester.

Bakersfield College Resources
e Web Resources:
BC Admissions and Records — www.bakersfieldcollege.edu/admissions/
BC Distance Learning — www.bakersfieldcollege.edu/distance _learning/
BC Grace Van Dyke Bird Library — www.bakersfieldcollege.edu/library/
BC Bookstore — www.bakersfieldcollege.edu/bookstore/
BC Counseling — www.bakersfieldcollege.edu/counseling/
BC Financial Aid — www.bakersfieldcollege.edu/finaid/
BC Supportive Services — www.bakersfieldcollege.edu/student/supportive/
e Phone Resources:
BC Admissions and Records — (661) 395-4301
BC Extended Learning, MOODLE—(661) 395-4635
BC Grace Van Dyke Bird Library — (661) 395-4461
BC Bookstore — (661) 395-4506
BC Counseling — (661) 395-4421
BC Financial Aid — (661) 395-4427
BC Supportive Services — Voice/TTY (661) 395-4334

Successful Study Suggestions

v' Consider your time commitments
Before signing up for an online course, consider your time commitments. An online class takes as much time if
not more as an on-campus class. Many online students write that they spend more time working on their
online classes than they do their on-campus classes.

v' Participate actively
You must participate actively in the class. Your instructor will not contact you. Contact your instructor and your
classmates if you have questions or comments.

v' Login to your class frequently
Check the course syllabus for specific course parameters, but at the very least: logon to your online course at
least twice a week during the fall or spring semesters, 3 or 4 times a week during summer session. Most online
instructors have due dates for assignments and tests. Many instructors will post weekly messages about due
dates and assignments. If you don’t logon at least once a week, you may fall behind.

v" Don’t fall behind
Don’t procrastinate. It's very easy to fall behind when you don’t have to physically attend a class. Once you fall
behind, it'’s very difficult to get back on track.

v' Ask for help when you need it
Don’t be shy. Although you won’t meet with your instructor, he or she will be available to answer
guestions and offer additional help via email. Email your instructor whenever you have a
guestion or a problem. Remember, check with your student peers within the class; they may
have encountered the same situation.
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Chapter 2

Successful Online Skills Survey [Do you have the right stuff?]

Is an online course right for you? INSTRUCTIONS: Answer the questions and then review the
explanations on the next page, to help determine your readiness for taking an online course. [Does the Online
course environment compliment your learning style?]

1. As a reader, | would classify myself as:
a. Good - | usually understand the text without help.
b. Average - | sometimes need help to understand the text.
c. Slower than average.
2. | rate my skills in completing the following Internet tasks:
* navigating the Internet,
* using email--including attaching a file to a n email message
» downloading a program from the Internet and installing it
* doing a search on the Web
a. Excellent
b. Good
c. Weak
3. When | am asked to use DVD players, VCRs, computers, voice mail, or other technologies new to me:
a. | look forward to learning new skills.
b. | feel apprehensive, but try it anyway.
c. | put it off and try to avoid it.
4. My need to take this course now is:
a. High - | need it immediately for a degree, job, or other important reason.
b. Moderate - | could take it on campus later or substitute another course.
c. Low - It's a personal interest that could be postponed.
5. Feeling that | am part of a class is:
a. Not particularly necessary to me
b. Somewhat important to me.
c. Very important to me.
6. | would classify myself as someone who:
a. Often gets things done ahead of time.
b. Has no problem getting things done on time.
c. Puts things off until the last minute.
7. Classroom discussion is:
a. Rarely helpful to me.
b. Sometimes helpful to me.
c. Almost always helpful to me.
8. When an instructor hands out directions for an assignment, | prefer:
a. Figuring out the instructions myself.
b. Trying to follow the directions on my own, then asking for help as needed.
c. Having the instructions explained to me.
9. | need instructor responses to my questions and assignments:
a. Within a week, so | can review what | did.
b. Within a few days, or | forget what | did.
C. Right away or | get very frustrated.
10. Considering my professional/personal schedule, the amount of time | have to work on online courses is:
a. six or more hours a week
b. four to six hours a week.
c. less than four hours a week.
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Explanations

The ten questions in the survey reflect some of the facts about taking online courses.

1. Textual materials presented on the Internet are the primary source of directions and information for online
courses; therefore, strong reading skills are very important for success in an online course.

2. You must be able to complete the following Internet tasks to be successful in an online course:
v' navigate the Internet
v"use emall, including attaching a file to an email message
v" download a program from the Internet and install it
v do a search on the Web.

3. Online courses require frequent and diverse uses of technology for accessing information
and assignments; therefore, you need to be comfortable working with various types of technology
to be successful in an online course.

4. Online students sometimes neglect courses because of personal or professional circumstances,
unless they have specific and compelling reasons for taking the course. Procrastination is the
most common pitfall in taking an online course; don't let it happen to you!

5. Some students prefer the independence of online courses; others find it uncomfortable.

6. Online courses offer students greater freedom of scheduling, but they can require more self-
discipline than on-campus courses.

7. Some people learn best by interacting with others. Online courses frequently do not provide much
opportunity for this interaction. The individual student must take responsibility for regularly
contacting other students and the instructor.

8. Online courses require more self-direction since face-to-face instructions are sometimes not
available.

9. In online courses, instructors are not able to respond to questions immediately as they do
in on-campus classes. Check the course syllabus

10. Online courses require AT LEAST as much dedicated time by the student as on-campus

courses. Typically, successful students report spending more time - not less - than for a regularly
scheduled class.
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Chapter 3

“Introduction to the Internet” [formerly “cutting edge”]

Basic Internet 101 [The history of...]

What the Heck Did You Just Say? That's usually the look | get when | try to explain an Internet term or
acronym. Most of the terms are fairly simple to figure out, but as an easy guide, there is a glossary of term at
the end of this manual that will help you whenever you become confused. Now, lets discuss first things first. In
order to comprehend the terminology, it's best to understand the Internet and how it works.

What exactly is the Internet? [Can you believe it was new and unfamiliar a decade ago?]

The Internet — also known as the Net — is the world’s largest computer Network. With Networks, size
counts for a lot, because the larger a network is, the more information it has to offer. The Internet

is often referred to as an 'ocean,' because of its enormity and power. Some people are said to

'surf,’ 'ride,’ or 'navigate' the net. It is probably more accurate to say most people 'swim' through the
Internet, until they understand navigating from one site to another.

The Internet is simply a series of computer networks linked to one another around the world, communicating
almost instantaneously with one another. (A single network of computers might be all the computers linked to
one another within an office or school building. A larger network might be all the computers connected within
an entire school district.) The Internet is many tens of thousands of these networks communicating with one
another, like a big net or web! University networks connected to government networks connected to business
networks connected to private networks - this is the Internet! These computer networks are physically linked to
one another with telephone, radio, and cable lines or via satellite. Networks from other continents are inter-
connected by the large, intercontinental telephone and fiber optic communication lines that run beneath the
ocean floor.

Nobody knows for sure how big the Internet is, or how many networks are actually linked, but it is estimated
that there are approximately 619 million people that are online, with sites on every continent. New user sites
are continually being added. In fact, the Internet has grown at an exponential rate since its beginning and is
growing at about ten percent each month. At the current rate of growth*, in just ten months from today, nearly
half of the users on the Internet would be using the Internet for their very first time. [*remember, this was written
over a decade ago when the Internet was still young.]

Connecting from Home [My, how technology has changed in a decade+]

To connect online, your computer must be equipped with a modem, a device that translates the digital signals
from your computer into analog signals that can travel over a standard phone line. Those are the scratchy
sounds you hear from a modem's speaker. Believe it or not, there is actually meaning in all that noise. A
modem on the other end of the line can understand it and converts the sounds back into digital information. By
the way, the word modem stands for Modulator/ Demodulator. Modems come in different speeds and are
measured in bps or bits per second. A 28.8 Kbps modem sends data at 28,800 bits per second. A 56 Kbps
modem is twice as fast, sending and receiving data at a rate of 56,000 bits per second. Most modems today
are 56 Kbps.

Why does speed matter? [Ask anyone who goes out to the Famosa race track]

On the Internet, you are constantly exchanging data with other computers. Some of these digital files can be
quite large. As you will soon learn, you want this exchange to happen as quickly as possible. If you are
purchasing a modem, get the fastest one available. If you have call waiting, you will want to disable it before
connecting online. If you're online and a call comes in, it will disconnect you unless you disable call waiting. In
most places you can enter *70 before the number you call for Internet service so that another call will not
interrupt you while you're on line.

1 Global Reach: Global Internet Statistics, http://www.glreach.com/globstats/ (June 2003)
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. ISDN [remember these?]
There are faster ways to transmit data by using an ISDN or leased line. In many parts
of the U.S., phone companies are offering home ISDN at less than $30 a month. ISDN
requires a so-called ISDN adapter instead of a modem, and a phone line with a special
connection that allows it to send and receive digital signals. You have to arrange with
your phone company to have this equipment installed.
J Cable Modems [that was “then’|
A relatively new development is a device that provides high-speed Internet access via
a cable TV network. With speeds of up to 36 Mbps, cable modems can download data
in seconds that might take much longer with a dial-up connection. Because it works
with your TV cable, it doesn't tie up a telephone line. Best of all, it's always on, so
there is no need to connect--no more busy signals! This service is now available in
some cities in the United States and Europe.
. DSL [thisis “now”]
DSL (Digital Subscriber Line) is another high-speed technology that is becoming increasingly popular. DSL
lines are always connected to the Internet, so you don't need to dial-up. Typically, data can be transferred at
rates up to 1.544 Mbps downstream and about 128 Kbps upstream over ordinary telephone lines. Since a DSL
line carries both voice and data, you don't have to install another phone line. You can use your existing line to
establish DSL service, provided service is available in your area and you are within the specified distance from
the telephone company's central switching office. DSL service requires a special modem. Prices for
equipment, DSL installation and monthly service can vary considerably, so check with your local phone
company and Internet service provider or Online Service.

What’s the difference between an ISP & an Online Service? [This is like explaining a “party line”]

o ISP [back in the ‘olden days...]

An ISP is a company that provides access to the Internet. For a monthly fee, the service provider gives you a

software package, username, password and an access phone number. Equipped with a modem, you can then

logon to the Internet and browse the World Wide Web and USENET, and send and receive e-mail. In addition
to serving individuals, ISPs also serve large companies, providing a direct connection from the company's
networks to the Internet. ISPs themselves are connected to one another through Network Access Points

(NAPs). The advent of ISPs has made connecting to the Internet an affordable and convenient option for many

people. In addition to providing access to the Internet, ISPs usually offer additional services as well. These

services can include:

v Web hosting - An individual or organization can place their web pages on a web server located at the ISP.
Internet users can then access these web pages.

v' Domain Name Service - Provides domain name servers, which are computers dedicated to translating a
customer's domain name into the actual numeric IP (Internet Protocol) address of the customer's
computer. Domain name service is integral to the proper functioning of the Internet.

v" Proprietary Online Services - Such as the custom services offered by America Online, Inc. or
CompuServe. These special options are available only to their subscribers.

ISPs charge a fee for the service of providing Internet access. Charges vary from region to region and can

depend on variables such as: 1.) type of connection, 2.) modem speed, and 3.) level of service

Some ISPs charge for each hour that a user is connected to the ISP. Other service providers allow unlimited

connection time once the user has paid a flat fee either by the month or by the year. Recently, a few new ISPs

that provide free Internet access have become available. Two of the most popular ones are Net Zero and Free

ISP. There are many sources of information about Internet Service Providers via the World Wide Web. Two

sources are: thelist.internet.com/ and www.isps.com/

. Online Service [Dated data]

An Online Service is a business that provides its subscribers with a wide variety of data transmitted over

telecommunications lines. Online services provide an infrastructure in which subscribers can communicate with

one another, either by exchanging e-mail messages or by participating in online conferences (forums) and
synchronous conversation (chat, instant messages). In addition, the service can connect users with an almost
unlimited number of third-party information providers. Subscribers can get up-to-date stock quotes, news
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stories hot off the wire, articles from many magazines and journals, in fact, almost any information that has
been put in electronic form. Of course, accessing all this data carries a price, and most Online Services’
monthly fees are a little higher than an ISP. Three of the largest online services are America Online,
CompuServe and MSN. The difference for you would depend on whether you just wish to use E-mail, and have
access to the Internet and the World Wide Web, or whether you want the additional fringe benefits offered by
an Online Service Provider.

Web Browsers [Refresher course]

OK, I'm connected to the Internet, now what? If you have an Online Service like America Online or
CompuServe, you will automatically be connected to their home page, and from there, you can connect to the
World Wide Web using whichever browser they provide to you.

TIP: Occasionally AOL’s browser will not work with certain Web sites, such as online course Web
pages. To overcome this problem, connect to your service like you normally do. Once you're connected
@ | You minimize the AOL browser and then open another browser to access the course Web pages.

With an ISP, depending on how your system is set up, chances are that after you connect, you will have to
open your own web browser in order to begin using the World Wide Web. The two most popular web browsers
are Internet Explorer and Netscape.

Internet Explorer *@

There are several version of Internet Explorer. The latest version can be downloaded from
www.microsoft.com/windows/ie/. Depending on your Internet connection and the speed of your modem, it
could take quite a while for you to download the program as it is rather large.

Netscape Navigator il
Netscape Communicator is the Inter suite (group of applications) from Netscape Communications that allows
you to browse the Web, do e-mail, participate in newsgroups, talk and hear people live, and even build your
own Web pages. Each application within the suite has a distinct function and name. Netscape Navigator is the
browser component (comparable to Internet Explorer) of Communicator. Use it to navigate the Web, or as
frequent users say — surf the Net. Download the latest version at channels.netscape.com/ns/browsers/default.isp

Mozilla Firefox @

Firefox is a free, open-source web browser for Windows, Linux and Mac OS X and is based on the Mozilla
codebase. It is small, fast and easy to use, and offers many advantages over Internet Explorer.
www.mozilla.com/en-US/firefox/

o Browser Versions

Having the new version of a browser often allows you to access a wider range of Web pages and multimedia.
This is because the Web is a constantly changing landscape and to keep up with the changes it is often
necessary to update your browser in order to take advantage of those changes. With skill in using just a
handful of the features in either Netscape or Explorer, you will be able to navigate the Internet easily and
comfortably. The following section will introduce you to the main features of the latest Windows version of both
Internet Explorer and Netscape Navigator. (Note: At the time of printing the latest versions were Internet
Explorer 7.0, Netscape Navigator 9.0 and Mozilla Firefox 2.0. The images you see were taken from these
versions and therefore may vary slightly from your version and settings.)

o A Browser Alternative

If you aren’t a fan of Microsoft’'s or Netscape’s browsers, you might want to try Opera, which is the most
popular “alternative browser.” Opera is compatible with both Windows and Macintosh-based systems, and also
is available for Personal Digital Assistants (PDAs). Opera is a full-featured browser and includes mail and
Usenet features, supports Java and JavaScript and enables you to navigate with your keyboard instead of your
mouse if you want. There is a free Opera version available for download but it does include a banner
advertisement. You can also purchase Opera to get rid of the banner advertisement.
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Browser Features [Just look around...]

. Title Bar
/4 Bakersfield College Home

Figure 3.2 Netscape Navigator Title Bar

) Bakersfield College - Mozilla Firefox Figure 3.3 Mozilla Firefox Title Bar

In the figures above, do you see “Bakersfield College Homepage”? This is the title of the Web page.

° Menu Bar

Fil= Edit Micw  Favoribes  Tools Hel .
i Figure 3.4 Internet Explorer Menu Bar

Fil= Edit Micw Go  Communicabor  Help

Figure 3.5 Netscape Navigator Menu Bar

File  Edit View Go Bookmarks Tools Help  figure 3.6 Mozilla Firefox Menu Bar

Would you like to see at a glance everything you can do with your browser? Point the mouse arrow at
File on the Menu Bar and hold down the button. Read the dropdown menu. Repeat for all the other
items on the menu bar.

e Toolbar Buttons
| 4mBack - = - | [8] | {4} | GEFavorites EfMedia £ QSearch | Sh [4 | D

Figure 3.7 Internet Explorer Toolbar

] Dack [Famward Meload I ame= Search Metscaps [rirak m
Figure 3.8 Netscape Navigator Toolbar

& - & @ Figure 3.9 Mozilla Firefox Toolbar

Do you prefer quicker access? The Toolbar gives one-click access to the most frequently used functions. With
the toolbar buttons you can go back a page, move forward a page, stop downloading a page, go home to your
start-up page, or print the current page. Find out which button on your browser does each of these previous
tasks.

e Address Bar
| Address I@ http: / fuaan, thesurvivalmanual . com)f Ll 'f'l’\'G'I' |
Figure 3.10 Internet Explorer Address Bar

| nratinee Ith';’f'www thezurvivalmannal coml? LI

Figure 3.11 Netscape Navigator Location Bar

|§: http: /ey bakersfieldcollege . eduf I
Figure 3.12 Mozilla Firefox Address Bar

Where are you? The Address Bar (called the Location Bar in Netscape) displays the address of the document
you are reading. The address is called a URL — pronounced” you-are-ell or Uniform Resource Locator. You
can enter new URLs in this space to take you to new places.
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Getting Around the Web [“ancient” history?]

e Hypertext Links

Hypertext links are what the World Wide Web is all about. Clicking on these hot links when the mouse had
appears will start you on a multimedia journey that can take you anywhere in the world. In the past you could
usually identify a text link quickly because they were almost always underlined and in the color blue. With
modern Web pages it is not always that easy to identify them. Today a text link can be any color and it need
not always be underlined. They turn grey when you move your mouse pointer over them. Links can also be
embedded in an image. If you look at the BC homepage you'll find several links embedded in images. The best
way to identify a hyperlink is by noting when the mouse pointer changes from an arrow to a hand.

TIP: Whenever the mouse pointer )
changes to a hand, there is a link

NOTE — that on return to the originating page, the hypertext link will often be a different color. This is to remind
you that you have “been there, done that”. There is a History that keeps a record of where you have been,
usually for 20 days.

e Entering URLs or Addresses
To go directly to a place, we must know the address. Every computer that is connected to the Web and every
Web page that is stored on that computer has a unique address. In Internet lingo this is called a URL. The URL
of Bakersfield College’s Homepage, for example, is www.bakersfieldcollege.edu/ You can enter an address
directly in the Address box underneath the Toolbar (as has been done in the diagram below for NASA).

| Address |&) MTYITEEEEY, - Figure 3.13 Internet Explorer Address Box

Alternately you can click on File > Open, or File > Open Page in Netscape, from the Menu Bar to get a
window into which you type an Internet address. When in this window, in Internet Explorer, you can click on the
down arrow to view a short history of the places you have been and from there you can click on any of the
addresses and travel to that page.

TIP: Once you have been surfing the Web for a while and frequent a site more than once, the browser
will initiate a feature called AutoComplete. This means that when you begin to type a URL you have
been to before the browser will complete your typing for you based upon the history. You can also

@ | choose from the Drop-down list of sites. Additionally, you don’t need to enter http://www. The browser
knows you want to go to a Web site and will fill in those bits of information if they are needed.

e The Back and Forward Buttons e =
Figure 3.14 Back and Forward Buttons B

The Back and Forward buttons are the standard way to move between pages. If you click on the down arrow
between the Back and Forward buttons, you will see a list of the most recent Web pages you have viewed.
Click on one for a quick return.

e History of where you have been

Browsers keep track of the pages you have visited. You may view the names of these pages by clicking on the
History button in the Toolbar, or in Netscape by going to the Menu and selecting Communicator > Tools >
History. A click on an earlier page will return you to that display.

. Home

Lastly, you can always go home — just click your heels twice. The Home button on the Toolbar returns you to
the page that has been set up as your start-up (or home) page. When your browser is first installed, it is set up
with a default home page which is usually the browser maker’s Web site. You can change this through: Tools
> Internet Options > General, or on Netscape Edit > Preferences > Navigator. Simply type in a new
address or
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http://www.bakersfieldcollege.edu/

» Use Blank to view a blank screen at start-up

» Use Current to designate the current page you are viewing as your home page

» Use Default to return to using the Microsoft Network home page (Internet Explorer only).
» Use Last Page visited (Netscape only)

e Printing

With most browsers you can print the page as you see it, portions of text from the document, selected pages
from the document, pages linked to that page — and more. Check your browser’s print dialogue box to
determine what types of printing options you have.

' TIP: Copyright Issues. It’s better to be safe than sorry, assume that all material on the Internet docu-
ment (graphics too) is copyrighted. That means it is O.K. to print for your private use, but not for reuse or
® | distribution (without the creator’s permission). Some sites will state that material is free for the taking.

e Help

All the browsers come with good documentation. Click on Help at the far right of the Menu Bar to see the drop-
down menu. Explore the Help menu on your browser and become familiar with the different kinds of help
available. Most browsers offer an index or contents, which let you browse or search for a topic of interest. Most
help menus also provide a link to the online support for that browser. Make good use of these resources.

e Getting Around with a Right Mouse Click

. . . Back.
Figure 3.15 Netscape Right-Click Menu Forward
Reload
] ) ] Stap
Figure 3.16 Internet Explorer Right-Click Menu
Yiews Source
YWieww Info
Reload
Add Bookmark.
Save Background As .. 1 Create Shorkout
Set as Backgraund Bookmark This Page... : Send Page
Capy Background Save Page As...
Set as Desktop ltem... T
¥ Send Link...
Select Al
‘iew Background Image
Create Shortcut Select Al L
Add to Favorites... i
View Source _ Yiew Page Saurce
Encoding v | ‘iew Page Infa
Print Properties
Refresh Send to b b
Export to Microsoft Excel Page Info ’
G| Google Search ) . . . .
Send To ’ Figure 3.17 Mozilla Firefox Right Click Menu
Page Info 4
Properties

You can use your right mouse button to “Travel through” pages and frames. Point the mouse at a patch of
clear space and click the right mouse button once. You will see a box similar to one of the ones shown above.
Choose either Back or Forward. Choosing Back will take you back one page and choosing Forward will take
you forward one page. You can go Back and Forward as many times as it takes you to get to where you
desire. There are other commands you can select from this Right-Click Menu. For more information on these
other options check your browser’s help menu or, find the latest tutorials by doing a search on a Web.
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Do you turn down the corners of pages as a reminder to go back to that page? Do you use post-its to mark
important sections in a book? As you follow these lessons and go to places on the web you may want to
“‘bookmark” special pages.

Getting Around the Web [Don’t get lost...]

Internet Explorer @

Explorer’s Favorites is an easy way to save the address of a Web page so that you can return to it quickly. For
example, if you come to a place and you know you will want to go back to it, you simply add it to your Favorites
list.

Favontes Tonk Help

. Adding A Favorite PO

1. Click on Favorites on the Menu Bar. Organico Favortos

2. Add to Favorites —1 ¥npoited bookmaiks

3. The name of the favorite is displayed. You may want to change j ;2’“

that name to something more meaningful. 21 WEN

It is that simple. Click on Favorites again and see the site on the list. €] Unicade

Click on the site name and you will be taken directly there. No need e

to look up the address and reenter it. #] vsicoms oo Insarmet Expiorar § Tour
&1 Lyoos imege Goleny

. Add to Favorite to a Folder Favorites

Adding a favorite to an existing folder or creating a new one is a breeze. When doing the Add, click on the
button Create In the choose an existing folder. If none apply, select New Folder.

o Another Favorite Way
There is another way to view your Favorites. Click on the Toolbar and view the favorites list in a frame to the
left of your screen. To quickly add the web site you are viewing to the list, drag the Explorer icon in the Address
box to any of the folders. Access to your favorite Web sites is also easy—just double click on the site you want.
o Managing Your Favorites
Favorites, with some housekeeping, will develop into your personal directory to information resources on the
Internet. Addresses you put in the Favorites list are stored permanently in the
. C:\Windows\Favorites folder.
You can view your complete list by clicking on Favorites, Organize Favorites. This will open a large window in
which you can see the favorites listed. You can rearrange these by dragging and dropping them.

Netscape Navigator =
o Adding A Bookmark

1. Click on the Bookmarks button on the Toolbar.

2. A drop-down menu appears which contains commands for adding, filing and editing bookmarks and also

some folders in which you may store the bookmarks that you collect.

3. Click the Add Bookmark command.

It is that simple. Click on Bookmarks again and see the site in the
list. Click on the name of the site from the list and you will instantly Add Bookmark

be taken there. No need to remember the address and type it in. File Bookmark 2
Edit Bookmarks...

o Another Way to Bookmark =
X i i (] Mewsletter Sources 3
You can also bookmark a Web site via the Menu Bar. Click on -

; [] Personal Toolbar Folder 3
Communicator and see the Drop-Down menu appear. Go to the 7 The|
Bookmarks option and click it, you will see a command for Add
Bookmark. Click it.

nternet Guide - Dermc
B My Sites
[ Subject Directories »

% Lilararies &

o Drag to Bookmark

Drag the Page Proxy Icon: 4

Page | 16




A neat way is to drag the page proxy icon (to the left of the Location field) to the Bookmarks button (1). The
Bookmarks menu pops up (2), and you continue to drag the icon down to the right spot. Release the mouse
and voila, you have bookmarked the Web page.

J Go To Bookmarks

You can view your complete list by clicking on Bookmarks in the Location Toolbar or under Communicator in
the Menu bar and then click on, Edit Bookmarks. This will open a large window in which you can see the
bookmarks listed. You can rearrange these by dragging and dropping them into a new order.

TIP: There is an even faster way to bookmark a site. On both browsers you can press the CTRL key
and B at the same time on your keyboard. The Bookmark or Favorites window open instantly, where
you can add the current page to your Bookmarks or Favorites list.

'

Using Search Engines [Where or where?]

You can locate useful or interesting web sites by using a search engine. This is a web site containing a huge
database of web addresses. You key in a subject or a name that describes what you are seeking, and the
search engine provides you with a list or selection of web pages that fit your inquiry. You then simply click on
an address to jump to that web page. Although search engine is really a general class of programs. The term is
often used to specifically describe systems like Alta Vista, Google and Yahoo that enables users to search for
documents on the World Wide Web and USENET newsgroups.

Typically, a search engine works by sending out a spider to fetch as many documents as possible. Another
program, called an indexer, then reads these documents and creates an index based on the words contained
in each document. Each search engine uses a proprietary algorithm to create its indices such that, ideally, only
meaningful results are returned for each query.

o Preliminary Searching Hints

1. Choose a search engine, directory or library in accordance with the kind of search you are doing and the
kind of results you are seeking.

2. Consider: Are you looking for a Web site? Information that might be contained within Usenet? Academic
articles that may only be retrievable with gopher?

3. Determine your aims: Do you want a specific hard-to-find document on an esoteric subject, or general
information on a broader topic? Do you need to search the entire Web, or is what you are seeking likely to be
found on a number of sites, or only the most popular sites?

4. In making your choice, determine whether the information you are looking for is likely to be in a page’s title
or first paragraph, or buried deeper within the document or site.

5. Use a search engine’s advanced features, if available, and read the help files if you are unclear about its
searching procedure.

o Choosing Search Terms and Syntax

1. Enter synonyms, alternate spellings and alternate forms (e.g. dance, dancing, and dances) for your search
terms.

2. Enter all the singular or unique terms that are likely to be included in the document or site you are seeking.
3. Avoid using very common terms (e.g. Internet people), which may lead to a massive amount of irrelevant
search results.

4. Determine how your search engine uses capitals and plurals, and enter capitalized or plural forms of your
search words if appropriate.

5. Use a phrase or proper name if possible to narrow your search and therefore retrieve more relevant results
(unless you want a large number of results).

6. Use multiple operators (e.g. AND, NOT) if a search engine allows you to do so.

7. If you receive too many results, refine and improve your search. (after browsing the results, you may
become aware of how to use NOT — e.g. Boston AND hockey AND NOT Bruins)

8. Pay attention to proper spacing and punctuation in your search syntax (i.e. no space when using + means
+term not + term).
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Which Search Engine Or Directory Do You Want? [Number please?]

» To browse a subject area...

USE Yahoo, Magellan (or for top sites, NetGuide Live or Lycos Pointcom Top 5%)

* To search Usenet...

USE Yahoo, Magellan, WebCrawler, AltaVista, InfoSeek or HotBot (or best of all, DejaNews)
* To include older gopher files in your search...

USE Magellan, WebCrawler or InfoSeek

» To search as much of the Web as possible...

USE AltaVista, Google or InfoSeek

» To search every word on a site or in a document...

USE AltaVista, Google, InfoSeek or HotBot

* To locate an obscure or hard-to-find document...

USE AltaVista, Google, InfoSeek or UltraSeek

* To locate a fairly popular site or easy-to-find document...

USE WebCrawler, Yahoo, or Magellan

* To retrieve a large number of results...

USE AltaVista or InfoSeek or a metasearch engine such as Savvy Search or Metacrawler
* To retrieve few but relevant results...

USE WebCrawler or Infoseek (for relevance)

» To search only titles, urls or keywords...

USE WebCrawler, Yahoo OR Alta Vista

* To specify in what part of a site your search terms will occur (including titles, URLs and summaries)...
USE AltaVista (adv) or InfoSeek

» To search reviewed and evaluated sites...

USE Magellan or Lycos Pointcom's Top 5% or NetGuide Live's Best of the Web

Advanced Search Techniques [What’s new Pussycat?]

It is quite easy to get discouraged when searching the Internet. Just about any search can result in hundreds,
thousands, or even millions of “hits.” For example, suppose you wanted to track down information concerning
community college online science courses. You choose to user Google and use the following key words:
community college online science courses. A simple search in most search engines will list EVERY site that
has ALL of the keywords entered! This lists approximately 551,000 sites. Obviously you cannot possibly view
the thousands of “hits.” You do not wish to see courses that are from social sciences, fire sciences, etc., and
you only wish to view community college information. Therefore, it is essential that one knows how to
customize searches using the various search locations available on the Net.

. Tips, Tools, & Tricks To Advanced Searches

* The more specific you can be the better. Don’t worry about redundancy — synonyms can help narrow the
fields of your search. Leave out nonessential words like prepositions and articles, (of, to, the, and so on) —
most search engines ignore them anyway.

* Add “Boolean Operators”. That’s just a fancy name for the words AND, OR, NEAR, AND NOT. Most search
engines accept the symbols + and — for AND and NOT, respectively. By entering these operators between
each keyword, it is quite easy to instantly decrease the number of hits, thus achieving a much higher
relevance.

* Surround specific keywords with quotation marks. This requires the search engine to locate the EXACT
PHRASE in order for it to be returned as a “hit.”

» Use wildcards such as * to include extra letters following the keyword letters entered. Now if you redo the
search with the following:

1. Place quotation marks around “community college”.

2. Place a minus sign in front of keywords you’re not interested in such as —social and —fire and — political.
Adding quotes and using the “-“ sign eliminated 516,000 hits! You can refine the search even more. Try
surrounding “online science courses” with quotes to see if you can find the exact phrase on a Web site. In
doing so, the search reduced the number of hits to 35 and the list is quite relevant. Please keep in mind that
there may be hits eliminated that are quite relevant but fail to have your keyword choices.
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Each of the search engines has a page with search tips. These tips explain how the search engine performs its
searches and how you can enter keywords, Boolean operators, and check special options to help refine your
searches. It's a good idea to get used to the special features and ways to search using only one or two search
engines, so you can become proficient in searching the Web. With millions of documents out there and only a
few that are relevant to your needs it is almost like finding a needle in a haystack, unless you know how to
effectively use a search engine.

Downloading and Plug-Ins [What’ll they think of next?]

. Downloading Made Easy [Easy for you to say...]
There are millions of place on the Internet where you can find free software (often called shareware or free-
ware), but they’re useless if you don’t know how to download and install software from the Web. Downloading
software is one of those skills—like using e-mail-that you usually learn by trial and error. Judging by the number
of questions we get on the topic, there are plenty of students out there who still haven’t perfected this skill
simply because no one has ever told them how to do it. Thus, we’ve put together a feature that should answer
your basic questions about how to download software from the Internet.
. Step-By-Step Downloading Guide [Ya put your right foot in...]

Here’s a step-by-step mini-primer on downloading software from the Internet. It's not as hard as it seems.
Step 1: Preparing a File for Download
For purposes of this exercise, you've found a file you would like to download at Shareware.com, which is a
popular place to download music on the Web. You'd like to download the free MP3 Player, www.winamp.com/)
which will enable you to play music on your computer from the Internet. This program is freeware, but if you
download shareware, and if you intend to use the complete program, you will eventually have to pay for it.
When you have determined you have enough disk space to download the file, the first thing you need to do is
select your operating system, and then follow the rest of the directions on the site. Once you click on the file,
you will be prompted to save it to your hard disk. There are two things you absolutely must remember: Where
you saved the file and what the file name was (jot this information down if you have to). After you've chosen a
place to save the file, your computer will begin downloading it, and you usually will be given an estimate of how
much time it will take.

TIP: One of the simplest ways to find files that you've downloaded is to save them to the desktop.
That way when you close your connection to the Internet and your web browser window, you will see
the files right on top of your desktop.

Y

Step 2: Don’t Forget to Exit Out of Your Browser!
Many people don’t realize that after they have downloaded the file, they must run through an installation
process to make the software work. Once you have downloaded the file, close your browser and find the file
you have just downloaded. Hopefully you have conveniently saved it on your desktop,
Step 3: Running Through the Installation Process

Double-clicking on the name of the file you have just downloaded will get the installation process going. You
usually will be prompted to answer a few questions, such as “What is your e-mail address?” and “What type of
browser you are using?” When the installation is complete, you can begin enjoying your new software.

. Computer Viruses [Take two aspirin...]
Worried about getting a virus from downloading a file from the Web? Well, it can’t happen from actually down-
loading the file, but you could encounter a virus when running the file (Double clicking the installation file is the
same as running it.). Here is some good advice: After downloading the file, and before double-clicking it, rerun
your antivirus software, you really need to buy some. There is a free antivirus scan/clean web site. It's called
Housecall and is located at www.housecall.antivirus.com/. You can use this until you get the software, but
remember, if the phone lines are down, or the site itself is being updated, you may not be able to clean a virus
in time.
. Zipped Files [Do0-Daa...]

If you've ever gone to download a file and have been scared off by the .zip extension, you aren’t alone. In
theory, “zipping” is a great idea: It's a way to archive and compress a group of files into one file for easier
storage and faster download. In practice, “unzipping” files can be a bit tricky. Hopefully, what we’ve put
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together in this manual will help educate you on what zipping is and will tell you what utilities you will need to
download “zipped” files.

o What is Zipping? [Don’t confuse it with a “zip” line]

Most downloads come as a group of files, including such things as the executable file (usually called
setup.exe), which will actually make the program run and a readme file, which typically has program
instructions. Often when you download from the Web, these compressed files are unzipped automatically (they
are called self-extracting Zip files). They do not have the zip extension (or for Mac users, the .bin or .hgx
extensions) but instead the .exe extension. You download these files by clicking on the file name and they
uncompress themselves, automatically creating a new directory and desktop icons. WinZip’s “What is a Zip
File, Anyhow?” page (www.winzip.com/aboutzip.htm) explains when and why Zip files are used. In addition, the
site explains the difference between Zip files and other archive files like ARJ, LZH, Gzip, and TAR. Sometimes
we have to extract the Zip files (easily recognized by their .zip extension) ourselves, in which case we need an
unzipping utility.

TIP: One of the simplest ways to find files that you’ve downloaded is to save them to the desktop.
That way when you close your connection to the Internet and your web browser window, you will see
the files right on top of your desktop.

Y

o Unzipping Utilities [no peeking...]
To download a .zip file, you will need an unzipping utility. After you have an unzipping utility on your system,
you simply download any .zip file and then use the utility to extract the group of files you need to run the
program. If you are a PC owner, you have several options when it comes to choosing an unzipping utility.
Check out CNET’s head-to-head comparison of WinZip and NetZip if you are deciding between these two
utilities. While CNET liked NetZip’s ability to resume dropped downloads, it ultimately declared WinZip the
champ, citing the product’s ease-of-use and abundance of features as its strengths. The unzipping and
compression utility of choice for Mac users is Stufflt Deluxe Download a fully functional trial version of WinZip,
PKZip, or Stufflt from the company websites.

o Plug-ins [no, it’s not an air freshener...|

Plug-ins are small programs which are loaded together with a larger application, and which enhance or add
capabilities to the larger program. For example, your browser can play sound and music, view movies, and
display special files with plug-ins such as Acrobat Reader, Quicktime, RealPlayer, and Windows Media Player.
In order to view these special files you will need to download and configure the plug-in software, unless that
software has already been installed and configured with your browser. You will know that you don’t have the
proper plug-in if you try to access a special file and it either doesn’t display, or you receive a message stating
that you must download the software.

Copy and Paste [Sticky situations?]
Copy and paste is just like it sounds. In Kindergarten you cut a picture out of a magazine and pasted it on
paper. In computer lingo, you copy (or cut) text or graphics and paste them in the same or another document.
Try it now — On your computer. Copy text from the screen and Paste into a text area in your Word Processing
program. Here’s how to do it:
« Highlight text then click the right mouse button — select copy.
* Move the pointer to the target location, click the right mouse button — select paste.

o Another method to Copy and Paste

' TIP: Highlighting — To select an area, hold the left mouse button down while moving the mouse. Or you
can hold the Shift key and then click with the left mouse button to extend a selected area. Ctrl + left
i mouse button may be used when a list of files is offered (add to/remove from list).

There is another method to copy and paste using the keyboard. Most Windows complaint programs use Ctrl-C
(hold down the “Ctrl” key and then press and release the “C” key) to copy the highlighted area, or the whole
page, and Ctrl-V (hold down the “Ctrl” key and then press and release the “V” key) to paste.
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Netiquette [DON’T YELL AT ME!]

Just as making your way around a new city requires that you learn a new set of rules, navigating the Internet
dictates that you adhere to a certain unspoken code of conduct. This online set of rules — called netiquette —
ensures that you are not misunderstood (and that you don’t offend anyone) when communicating online.

The Netiguette Home Page, www.albion.com/netiquette/index.html which covers common courtesy online, is a
great place to start. New users will learn the basics, such as how not to shout at someone in an e-mail (don’t
use all caps), how not to annoy an entire chat room (don’t hold your finger down on one key an continuously
press enter, called scrolling) and how not offend and enrage the e-mail masses (keep the Spam — or
unsolicited mass e-mail — to a minimum). The | Will Follow website at www.iwillfollow.com/email.htm maintains
a guide to E-mail Etiquette, which covers basic e-mail do’s (such as be concise) and don’ts (such as don’t use
special formatting). The site also provides interesting facts about e-mail (it is predicted that long-distance
phone bills will go down as e-mail becomes the favored mean of communication), lists of ematicons (like :-D,
for example) and lists of acronyms commonly used in e-mail. To personalize your messages, you can use
smileys, or emoticons, - expressions you create from the characters on your keyboard. A few popular ones
include:

-) Happy . -

:-e Disappointed -D Laughing
:-( Sad :-@ Screaming
:-< Mad ;-) Winking

:-0 Surprised :-I Indifferent

Chapter 4
Using E-Mail

What is E-Mail? [Are you serious!?!]

Within an enterprise, users can send mail to a single recipient or broadcast it to multiple users. With
multitasking workstations, mail can be delivered and announced while the user is working in an
application. Otherwise, mail is sent to a simulated mailbox in the network server or host computer,
which must be interrogated.

An e-malil (electronic mail) system requires a messaging system, which provides store and forward
capability, and a mail program that provides the user interface with send and receive functions.

The Internet revolutionized e-mail by turning countless incompatible islands into one global system.
The Internet initially served its own members, of course, but then began to act as a mail gateway
between the major online services. It then became "the" messaging system for the planet. In 1998, it
delivered more than 3.4 trillion messages in the U.S.

Sending Mail [need a stamp?]

Most Internet users have an e-mail address which takes the form of his or her name, the @ (at), and a
domain name, such as roconnor@yahoo.com. The domain name contains the name of the
person’s service provider or organization and often its country, each separated by a dot. The domain
name yahoo.com stands for Yahoo, which is a commercial Internet organization (com). E-mail offers
you more than a quick and easy way to send people written messages. It is possible to use e-mail to
send computer data, such as word-processed documents and images.

Composing an e-mail message is similar to writing a letter and sending it to someone via the United
States Postal Service. You create text, you address it with an accurate address, and sometimes you
even write a note on the envelope to indicate something special about the contents inside, such as
“personal” or “urgent.”

The biggest difference between e-mail and USPS mail is the speed at which your message is delivered
to the recipient. After you use e-mail and get used to its almost instantaneous delivery system, you’ll
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begin to understand why computer users have adopted the jargon “snail mail” for mail sent through the
USPS. To compose a message in most email programs; you carry out the following three steps, all of
which are quite easy:

1. Fill out the message header. The message header is the top part of the

message form. It contains items such as recipient and subject.

2. Write the message

3. Send the message

Opening Mail [You’ve got mail!]

Mail you receive is stored in the Inbox of your mailbox. You can see the list of messages in the Contents pane
by selecting the Inbox object in your E-mail’s Folder pane. When you see the list of messages in the Contents
pane, the header information helps you decide which messages to read immediately and which messages to
leave for later. You can use the priority icons and the subject matter to decide, or you can just pick messages
sent by people from which you would like to hear. Scroll through the list to find a message you want to open.
Double-click it, and the message opens in a message window. The buttons on the message window toolbar
provide quick access to many of the options you might need for working with received messages.

Free/External E-Mail Free

If you haven’t gotten email yet, there are plenty of FREE email services available on the Internet. Two of the
most popular ones are Hotmail and Yahoo mail. There are plenty more to choose from if you don’t want to use
either of these. You can do a search for free email on any search engine to see a large listing of these
services. Be aware that the free email services often come with some unappealing features and issues, such
as banner ads and mailbox clogging spam (unsolicited email advertisements).

Attachments

What is an attachment? An attachment is a file or an object that is attached to a message. You can place
attachments in messages you send, and you can receive messages with attachments. The usefulness of
attachments is unlimited, but the most common reason for attaching a file to a message is to send some
information without having to type it into the original message. For example, if you want to send information
you received (or wrote) in a word processing document to your instructor, you can compose a message that
explains that you have this information and then you can attach the specified document to the message so the
recipient can read the information. The mailing program allows just such possibilities. Not surprisingly, the
command to do this is "Attach", and it can be initiated by clicking on the browser button having this name.

Sending Attachments

Most email programs allow you to attach one or more files to your email message. The program automatically
encodes attachments when you send your message. However, the recipient’s email program may or may not
be able to automatically decode the attachment back to its original format. It is important to keep in mind that
your recipients must have a machine and program capable of using the attachment after it is received, whether
or not their email programs can decode the file. For example, if you attach a Word Perfect file and send it to
someone who does not have Word Perfect itself (or a program capable of translating the file), the attachment
will not be useful to him or her. If you send a Macintosh program to someone reading email on a Unix machine,
it will be useless. To send an attachment with Yahoo mail (procedure will differ with other mail programs):

1. Create a new message in the Send Message or Compose menu bar

2. Click on the Edit Attachments hyperlink.

3. The following dialogue box (figure 4.1), or something similar will appear.

4. You will need to identify the location of the document you want to attach by either typing in the location in the
File text box, or by clicking on the Browse button and locating and highlighting the name of the document.

5. Once you OPEN the file in the browse dialogue box, it will take you back to the Add Attachments window
and will have the name and location (or path) of the file entered.

6. You next click on the Attach button

7. Then click on the Done button

8. The program will take you back to the Compose Message Window.
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When a message with an attachment arrives in
your mailbox, a paper clip icon appears next to
the message in your Inbox (figure 4.2). To
open the message, click on the Attached File
hyperlink. The dialogue box appears with
options for the attachment.
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Figure 4.4 Download Attachment window

Conclusion — Responsibility in a Virtual World [some things never change...]

The Internet is a strange and wonderful network that has made it possible for people all around the world to
connect with each other in meaningful ways. Whether for research, education, business, or fun, the Internet
has changed how many of us live, work, and play, in ways we may not even be fully aware. As the Internet
continues to evolve, so do the issues that impact the way we use it. Whether you are the consummate hacker
or just an occasional driver on the information highway, you play a role in determining the future direction of
this road. From privacy, security, and freedom of speech to honesty and consideration in the way we interact
with others, we all have a responsibility to preserve and protect its unique character. That means recognizing
that while the medium is in many ways a reflection of the physical world, it is in other ways, fundamentally
different -- manifesting its own customs and practices.
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Appendix

Online Dictionaries, Encyclopedias and Translation Utilities

Tech Dictionaries and Encyclopedias: [What was in the beginning...]

The plethora of new tech terms can be intimidating, especially to the new computer user trying to get educated
on the ways of the computer world. So, if you don't know ISP from ISDN from IRC, don't fret. There are plenty
of online computer dictionaries and encyclopedias that explain technology concepts in simple terms. Here are
some of the best:

* Whatis.com www.whatis.com

* PC Webopaedia www.pcwebopaedia.com

» TechWeb's Technology Encyclopedia www.techweb.com/encyclopedia/defineterm.cgi

* NetLingo www.netlingo.com/

* Free Online Dictionary of Computing www.wombat.doc.ic.ac.uk/foldoc/index.html

Online Translation Utilities:

Whether you want to read a Web page in a foreign language or translate e-mail into your native tongue, there
are translation resources online that can help you out.

- Travlang's Traveling Dictionaries www.dictionaries.travlang.com/ are free interactive utilities that enable you
to translate more than a dozen languages, ranging from Spanish to Afrikaans.

- Alta Vista's Translation Services www.babelfish.altavista.com/translate.dyn enables you to translate between
English and about eight different languages. Just cut and paste the text into the search box, and the service
will translate it instantly for free.

HTTP Status Codes [Are these even used anymore?]

Whenever you are typing in URLSs, in the address bar on the Internet, the chance for an error is imminent.
What usually comes back is an HTTP Status Code. Fortunately, the list of HTTP Status Codes is fairly short.
Successful Transactions:

» 200: The request was fulfilled.

» 201: The POST request was completed successfully.

» 202: Request accepted for processing of unknown type. Rare.

+ 203: Request partially fulfilled.

Redirection Transactions:

» 301: The requested resource has been permanently moved to a new URL. Usually accompanied by Location:
new URL, which automatically connects to the new URL.

» 302: Requested resource found, but at a different URL. You'll get a 302 redirection if you omit the trailing
slash when pointing at a directory (sometimes called a malformed request).

» 304: Unmodified data not returned in response to a GET request with the If - Modified-Since field. Occurs
when a browser requests data found in cache.

Error Messages:

* 400: Error in request syntax.

* 401: Request requires an authorization field, and the client did not provide one. This response is
accompanied by a list of acceptable authorization schemes use WWW-Authenticate response headers. Error
401 can be part of a client/server dialogue to negotiate encryption and user authentication schemes.

* 402: The requested operation costs money, and the client did not specify a valid charge to field.

* 403: Request for forbidden resource denied.

* 404: Requested resource not found.

* 500: The server has encountered an internal error and cannot continue processing your request.

* 501: Request okay but denied because server doesn't support transaction method.
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Admissions & Records Phone Number: 395-4301

Apply online or update your information by using our online Admission/Update Form.
Did you know that you can check your grades online?

If you are unsure how to get started at BC, you can use our Enrolling at BC link to help you with the process.
In our Other Forms section, you'll be able to download some common Admissions & Records forms.
If you are a current student, you can register for classes online.

Need to review your schedule of classes?

All the information you need about official and unofficial transcripts can be found here as well.

Welcome to the Bakersfield College Enrollment and Registration Guide. This guide will help you through the important steps
that each student must complete in order to get started at BC, and get an early registration appointment for each semester
that you return. http://www.bakersfieldcollege.edu/admissions/enrolling/

As a new student ...

If you have received a two-year or higher degree from

another school but are new to BC, you are exempt from

the requirements for orientation, assessment and
counseling. However, we encourage you to take
advantage of any of these services you find helpful.

Admission or Update

Submit completed admissions form:
e online
Foreign students holding visas must contact

the Admissions & Records Office for
admissions procedures

Orientation

As anew student ...

Students are expected to participate in an orientation
session before assessment testing.

Online

e Online Orientation

In-person orientation schedules can be found:

e orientation schedule

e in Admissions and Records on main campus
e atthe Delano Community Campus

Assessment

As a new student ...

You must participate in assessment if you plan to:

e take an English, Math, or other class with
prerequisites

e earn adegree

e earn a certificate

e transfer

Students can request:

e English as a Second Language assessment
by calling 395-4479

e Accommodations for disabilities - 395-4334

Page | 26

As a continuing student ...

Enrolled in current semester classes

Admission or Update

Submit update:
e online

Orientation

As a continuing student ...

If you attended orientation, skip this
step.

If you never attended an orientation,
you are expected

to participate in orientation before
assessment

Assessment

As a continuing student ...

If previously completed BC assessment,
skip this step.

As aformer student ...

Enrolled in BC classes in the past but
not in the current semester

Admission or Update

If you attended:

e before 1987, complete
admissions as for new students

e 1987 or after, complete update as
for continuing students

Orientation

As aformer student ...

If you attended orientation, skip this
step.

If you never attended an
orientation, you are expected to
participate in orientation before
assessment

Assessment

As a former student ...

If previously completed BC
assessment, skip this step.


http://www.bakersfieldcollege.edu/application.asp
http://www.bakersfieldcollege.edu/login.asp
http://www.bakersfieldcollege.edu/admissions/enrolling/
http://www.bakersfieldcollege.edu/admissions/forms/
http://www.bakersfieldcollege.edu/login.asp
http://www.bakersfieldcollege.edu/login.asp
http://www.bakersfieldcollege.edu/admissions/transcripts/
http://www.bakersfieldcollege.edu/admissions/enrolling/
http://www.bakersfieldcollege.edu/application.asp
http://www.bakersfieldcollege.edu/application.asp
http://www.bakersfieldcollege.edu/application.asp
http://www.bakersfieldcollege.edu/application.asp
http://www.bakersfieldcollege.edu/application.asp
http://www2.bakersfieldcollege.edu/counseling/gs/online.html
http://www.bakersfieldcollege.edu/academic/schedule/orientation.asp
http://www.bakersfieldcollege.edu/academic/schedule/assessment.asp

New Student Workshop

As a new student ...

e The workshop will help you:

e review assessment and other criteria for
course placement

identify your educational goals

choose classes

inform you of special services

Online New Student Workshop

In-person workshops can be scheduled by
calling the counseling office at (661) 395-
4421

Registration

As a new student ...

Open web registration begins late in a semester for
the following term. Check the important dates page
for details.

Students should register for the waitlist for closed
classes. Instructors will not be signing add slips.

New Student Workshop

As a continuing student ...

e The workshop will help you:

e review assessment and other
criteria for course placement
identify your educational goals
choose classes

inform you of special

services

Online New Student Workshop

In-person workshops can be
scheduled by calling the
counseling office at (661) 395-
4421

Registration

As a continuing student ...

Students who are fully matriculated and
enrolled in classes on Monday of the
third week of a semester will receive an
appointment for early registration for the
following semester.

Students should register for the waitlist
for closed classes. Instructors will not
be signing add slips

MOQODLE [what in the world is “Moodle”?!?]

 Where is my Online class (Moodle)?
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NEW > http:/inside.bakersfieldcollege.edu

New Student Workshop

As a former student ...

The workshop will help you:

e review assessment and
other criteria for course
placement

e identify your educational
goals
choose classes
inform you of special
services

Online New Student Workshop

In-person workshops can be
scheduled by calling the counseling
office at (661) 395-4421

Registration

As a former student ...

Open web registration begins late in
a semester for the following term.
Check the important dates page for
details.

Students should register for the
waitlist for closed classes.
Instructors will not be signing add
slips



http://www2.bakersfieldcollege.edu/counseling/NewStudent/index.html
http://www2.bakersfieldcollege.edu/counseling/NewStudent/index.html
http://www2.bakersfieldcollege.edu/counseling/NewStudent/index.html
http://www.bakersfieldcollege.edu/academic/important_dates/
http://www.bakersfieldcollege.edu/academic/schedule/waitlist.asp
http://www.bakersfieldcollege.edu/academic/schedule/waitlist.asp
http://www.bakersfieldcollege.edu/academic/important_dates/
http://www.bakersfieldcollege.edu/academic/schedule/waitlist.asp

Glossary [4h, so that’s what it means...]

In this glossary you will find a definition to all those complicated techno abbreviations, acronyms and catch
phrases.

Anti Virus Software: A program, which is written specifically to locate and remove harmful viruses from your
PC. These programs constantly have to be updated to cater to new viruses, as they become known.
Browser: An application program, which interprets HTML and presents the final Web Page. Used to "Surf the
WWW". Examples include: Internet Explorer, Netscape Navigator, and Opera.

Client-Server: Client-Server is a type of computer architecture that distributes the processing of a computer
application between two computers the client & the server - the principal being to exploit the power of each.
The Client is normally a PC. The Application Program will access data and perform processing on the Server
and using the data obtained via the server more processing tasks will be performed on the Client. More than
one user can use the application.

Compression: A technique used to considerably reduce the size of a file without losing any of the original
information. The compression process alters the content of the file but this can and is completely recovered by
reversing the process.

Cookie: A file that is written to your Hard Disk when you access certain Web Pages. The file contains certain
information, often information that you entered when you displayed the page. The next time you access this
page a check is done to see if the Cookie exists. The information within the cookie may well influence what
happens next.

CPU: Central Processing Unit.

CTRL: An abbreviation that represents the control key on the keyboard.

Cursor: A flashing rectangle or line on the screen that shows exactly where you are working. For example,
when using a Word Processor the cursor indicates the point at which the characters being typed will be
inserted.

Cut and Paste: Just like when we were in Kindergarten - only using the PC instead of scissors and glue. This
allows us to remove sections from one document (cut) & place them in another document (paste).

DNS: The Domain Name System is how the Internet links together the thousands of Networks that it is
comprised of. The DNS is utilized whenever you send an Email or access a particular Web Page. The DNS
converts the Domain Name requested by an Internet User into an IP Address. The location of the machine with
this IP address is known and the information being requested can then be found.

Domain Name: The Domain Name is a unique name that represents each computer on the Internet. (Some
machines do have more than one Domain Name.) These Domain Names are converted to a unique number
known as an IP address (the IP stands for Internet Protocol). You will often see the IP address displayed by
your Web Browser when you are connecting to a particular computer. "www.yahoo.com" is an example of a
Domain Name. The "com" (sometimes called the top-level domain or the suffix) indicates that Yahoo is a
commercial Organization. Other top-level domains include:

ac - Educational institution int - International Organizations

co - Commercial organization mil - Military government organizations

com - Commercial organization net — Networks

edu - Educational institution org - non-profit organization

gov - Non-military government organizations us — Located in the U.S.A.

Download: To copy files from another computer to your own PC via a network or using a modem.

Drag and drop: This term relates to a GUI (Graphical User Interface). You can drag a file by clicking its icon
with the left-hand mouse button depressed and moving the mouse pointer - the file is dragged along. When
you let go of the file pointer the icon is released or dropped. You can use this technique to move a file between
directories.

E-Commerce: Business that takes place between companies using services such as the Internet, Electronic
data Interchange or Electronic File transfer. Two companies, one the supplier and the other the customer can
transmit inquiries, orders, invoices, payments etc. directly through their computer systems.
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Email: Electronic Mail - a way of sending other people messages from your PC. Widely used facility on the
Internet that basically sends addressed messages over a Network. The message normally gets there in a
couple of minutes.

Emoticon: Characters which express human emotions - you may need to rest the side of your head on your
left hand shoulder to appreciate them - however some word processors such as Microsoft Word will auto-
matically convert these to the icons. Examples include: - Happy :-) A big smile : D Sad :-( Boredom or
Surprise :-o Indifferent :-| A smile & a wink ;-)

FAQ: Frequently Asked Questions - a term used in magazines and by Software companies to provide users
with answers to those questions that are most often asked.

Firewall: A combination of specialized hardware and software designed to keep unauthorized users from
accessing information within a networked computer system.

Frame: This term has many different uses but by far the most frequently used is in relation to Web pages
where the Web page being viewed has a number of independent boxes or frames. A common application of
this is where you see, in the left hand frame, a menu displaying different areas of the Web site. You click on
one of the items in the menu and the result is presented in the right hand frame

FTP: File Transmission Protocol - a standard for moving Files from one computer to another. Say you have a
master copy of this document that you want to put on the Internet. When you make changes to it you use FTP
to transfer the updated files to the Internet Service Provider. You can also use FTP on certain computers on
the Internet to transfer files to your home computer. A computer on the Internet that specifically stores files for
users to FTP to their own computers is called an FTP Site. If the FTP site does not require the user to have
their own specific User ID and password, it is called an Anonymous FTP Site.

GIF Files: The most common type of image file used on the Internet. These files are compressed so they take
up the minimum amount of space and can therefore be downloaded a lot quicker than other graphics file. GIF
files are typically used for backgrounds, displaying banners, advertisements and buttons. These files unlike
other graphical file types are limited to 256 colors.

Gopher: An application whose purpose is to locate, retrieve and record information from the Internet.
Developed at the University of Minnesota in 1991, the word Gopher takes its name from the words "Go for" -
somebody who goes and gets anything that you ask of him or her.

Graphic: A picture or non-text item within a document. Most Web pages will contain a number of Graphics.
Homepage: The page by which a user normally enters a web site. A homepage is considered the beginning or
main page of a Web site.

HTML: Hypertext Markup Language - the text based language used to construct web pages, and interpreted
by Web Browsers. Web pages are a collection of HTML instructions, which you can see by using the View
HTML Source option from your Web Browser’s menu.

HTTP: Hypertext Transmission Protocol is a Protocol that computers on the Internet use to communicate with
each other.

Hyperlink: An often highlighted and underlined phrase or word on a web page that can be clicked on to go to
another part of the page or even to another web page.

ICQ: ICQ stands for "I seek you". It is an Internet program that notifies you of other users who are on the
Internet and enables you to initiate contact with these users. You can chat, play computer games, and send
messages to them. For more information on ICQ, go to www.icq.com/.

Internet: The Internet is a worldwide computer network through which you can send a letter, chat to people
electronically or search for information on almost any subject you care to think of. Quite simply it is a "network
of computer networks". It originated in the 1960's in the USA when the United States defense was conscious of
having its computer network destroyed by blowing up the central computer. A network was designed around
the principle of "unreliable computers"” - if one was destroyed or failed the remaining computers could still
function. Each computer in the network acknowledges the existence of all of the others.

IP Address: The Internet Protocol address is a unique number that is used to represent every single computer
in a Network. All the computers on the Internet have a unique IP address. The format of the IP Address is 4
numbers separated by dots e.g. 198.123.124.7.

IRC: Internet Relay Chat is the CB Radio of the Interne t. Basically you can "chat" to a number of people by
typing simple messages on your keyboard and they are responded to by one or more people from all over the
world who happen to be "chatting” to you via IRC.
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ISP: Internet Service Provider or sometimes referred to as Internet Access Provider (IAP) is a company which
provides access to the Internet for people and businesses. The company handles the link from your PC to the
rest of the Internet. The ISP’s central computer is linked to the rest of the Internet so the person using this
service only pays the telephone charges to connect from their home computer to the ISP’s central computer.
JPEG: JPEG is a type of image file used on the Internet. It is most commonly used for photographic

type images where there are more complicated gradations of hue or shade. Unlike GIF files JPEG files cannot
have transparent areas.

Link: A component of a hypertext document which when clicked with a mouse takes the user to another
document or a different section of the current document. The word "mouse" above in this paragraph - which
you can see is underlined and blue is an example of how a link appears most of the time on the Internet.
Login/Logon: These are the terms for the process of actually gaining access to the resources on a particular
computer - normally this is done by entering a user id and a password.

Logout/Logoff: The process of actually ending your access to a particular computer.

LOL: Laughing Out Loud - an abbreviation used in E-mails and chat rooms. There are a lot of abbreviations for
both email and chat rooms. A good source of definitions can be found at Alphabet Soup Explained:
www.members.aol.com/nigthomas/alphabet.html

Mailbox: The file or directory where your incoming e -mail messages are stored on the computer of your
Internet Service Provider.

Mailing/Distribution List: A single E-mail address comprised of several different E-mail addresses. For
instance your local college may have a mailing list called "Staff" which contains all of the E-mail addresses of
the staff on campus.

Mirror site: An exact copy of a popular website on a different file server — designed to spread the load. The
BMW car company has a mirror site - the main site is in the UK, but the majority of users access the mirror site
in the United States.

Modem: Modem comes from the two words Modulation and Demodulation. A Modem converts information
from Ana log to Digital and vice versa. Digital Information is represented in a series of 1's and 0's. Analog
information varies continuously such as a sound wave. Typically when you send Email, your Modem converts
the digital E-mail message to analog.

MOODLE: The CMS—Course Management System via which BC’s Online courses are delivered or use as a
portal. The CMS was selected and is supported by the KCCD and provides “uniformity” to all Online classes
via colleges within the KCCD (BC, PC, CC).

MPEG: Moving Picture Experts Group - a standard used on the World Wide Web for video and audio files -
compression techniques are used which enable the files to be transmitted across the internet significantly
quicker than other audio and video files. The web browser you are using must be capable of running MPEG
files.

Multimedia: Multimedia is the presentation of video, sound, graphics, text and animation by appropriate
software.

Network: A network is basically a series of wires and cables that connect a number of computers. Data is
exchanged between computers via these cables. The maximum speed at which the data can be transmitted is
called the bandwidth.

News Group: News groups are one of the many facilities available on the Internet. Like most of the Internet,
News groups are run voluntarily and co-operatively by people like you and me. A News group is centered on a
discussion topic an example being rec.sport.swimming. Within these News groups several discussions or
threads take place on themes within the discussion topic. A news group devoted to mythological TV characters
may have a thread about who is the best fighter out of Xena, Hercules and Gabrielle for instance. If you are
having a problem getting something specific to work on your computer there will definitely be a news group to
which you can post your problem and it won't take long to get a lot of responses. Unfortunately news groups
appear to be the vehicle for a majority of the more undesirable topics that pollute the Internet. If you see a
particular News group of interest you can "subscribe" to it. Once this has been done you "post" your article and
eventually it can be seen by anyone else who subscribes to that particular news group.

Online Service: A service available to all of us providing things such as access to the Internet, news, special
offers for its members, information, and chat groups. The most popular of these are AOL, CompuServe and
MSN.
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Operating System: The operating system, sometimes just called the OS, is the software that is responsible for
coordinating all the functions of your computer such as control and utilization of the hardware and peripherals.
Examples include: DOS, LINUX, MAC OSX, UNIX, WINDOWS 2000.

Page: A single HTML document on the World Wide Web. When you are looking at a website, a page is
generally what you see in a single browser's frame. If you click on a link it takes you to another page.
Password: The password is a code known only by a user to ensure that the individual who is trying to Login to
the computer is the actual person that the User id being used belongs to.

PC: The Personal Computer - Quite simply, a computer designed to be used by one person at a time. The
term “PC” is sometimes used to specify that the computer is an IBM compatible computer rather than a
Macintosh.

Plug and Play: The concept of adding new components to a PC (such as an external modem) without having
to manually configure anything - the operating system does it all for you.

POP: Post Office Protocol - the standard for exchanging E-mail between a users PC and their Internet Service
Provider.

PPP: Point-to-Point Protocol - Standard for using a modem and telephone line to connect to the Internet using
TCPI/IP.

Protocol: A standard process, a set of rules and conditions that perform a particular function. A word which is
very common in PC and Internet terminology. Some examples include: FTP — File Transmission Protocol; IP
Address — Internet Protocol address; TCP/IP - Transmission Control Protocol/ Internet Protocol; POP - Post
Office Protocol.

Radio Button: Radio buttons appear a lot in Windows’ applications. They are used to make a choice, i.e. an
online Multiple Choice test would contain radio buttons so the student could choose “a” “b” “c” or “d”.

Real Audio: Software that allows sound files to be transmitted from the Internet back to the users PC in
streams. What actually happens is that the file starts playing (i.e. you hear the music) before all of the data has
been received - giving the effect of playing the sound instantaneously

RTF: A file format - stands for Rich Text Format. Developed by Microsoft. Most word processors can process
RTF files - the format was developed to enable documents to be transferred between application programs.
Rich Text Format Files have the file extension RTF.

Screen name: A term specific to AOL (America Online) that denotes the name of the user.

Search Engine: One of the most essential tools on the Internet - they help you find web sites relating to a
particular subject or the E-mail address of someone you know or articles posted to a Newsgroup or even
companies which have a presence on the Internet. Most of the information provided by search engines is
categorized so the search can be considerably refined before you even begin. Search engines are basically
huge databases containing millions of records, which include the URL of a particular web page along with
information relating to the content of the web page. The search engine obtains this information via a
submission from the author or by the search engines performing a "crawl" using "robot crawlers" over the
Internet for information. Some search engines use Spiders to obtain information. There are a number of
facilities available on the web that allows authors to submit their web pages to hundreds of web sites at once.
Some search engines use a technique known as ICE to locate information on related topics. The most popular
search engines are: Yahoo, Alta Vista, Excite, Google, Hotbot, Infoseek, Lycos, and WebCrawler.

Signature: The three or four lines at the end of an E-mail message that provides additional information about
the sender. Application programs such as Internet Mail allow an E-mail user to create a default Signature that
will appear on all E-mails sent. Most people include their E-mail address and a link to their web page if they
have one.

Site: A group of Web Pages that collectively represent a company, or individual on the web. A group of Web
pages that have been developed together to present information on a specific subject is also a Site (some may
say a site for sore eyes).

SMTP: Simple Mail Transfer Protocol. An accepted standard used extensively on the Internet for transferring
E-mail messages between computers - The standard defines exactly how the message will be sent, any
controls, format of the message etc.

Snail Mail: A term used to describe the traditional mail or post office service. A note will take seconds to go
from London to Sydney via E-mail but a number of days via Snail Mail.
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SPAM: E-mail sent to people whom in no way asked for the information — normally done in huge numbers to
promote a product.

Spider: A search engine, which obtains its information by starting at a specified Web Page and visiting each
Web Page that has a link to it from the current page that the spider is accessing. This process continues as it
moves it way through the World Wide Web.

Surf: Surfing the net - the most popular activity on the World Wide Web. Looking around the Internet, jumping
from web page to web page just going to wherever strikes your fancy at the moment. Just like when you sit
with the remote control in your hand flicking through the TV channels - the Internet requires much bigger
batteries though.

TCP/IP: TCP/IP stands for Transmission Control Protocol/Internet Protocol and is quite simply a standard set
of protocols that was implemented in 1982 and that governs the basic workings of the Internet. The TCP part is
all about ensuring that data is transmitted correctly between two computers. If any errors occur these are
detected and the data is retransmitted. The data transmitted is split up into small portions called data packets.
The IP part of TCP/IP is how these data packets are moved from one point to another. Each computer on the
Internet has a unique IP address and the data packets are moved from the source to the destination through
many different computers and this is controlled via TCP/IP. This protocol is used on the Internet and also by
computers, which are part of a LAN.

Teleconference: A conference held between a number of people in different geographic locations. Each has a
PC with a video camera attached. Each person is recorded on the camera and the image is played back on the
other participants PCs by a special application program.

Telnet: Telnet is program that is part of the TCP/IP protocol. Its purpose is to allow a user to logon to a
computer from a remote location.

Thumbnail: A small version of an image (about the size of your thumbnail).

Thread: This term has many different meanings but the most common is with respect to E-mail and
newsgroups where a thread is basically a series of messages or postings all related to the same topic.

Timed Out: Timed out is a term used widely in the world of Information technology and indicates that some
predefined amount of time has been exceeded. If you connect to the Internet or a network and do not use the
system for a few minutes then you may get timed out i.e. logged off. This generally happens to free up a
connection for someone else to use.

Toolbar: The Toolbar sits across the top or down the side of a particular Window. The toolbar allows the user
to perform certain tasks such as opening a file or submitting a print. The toolbar can usually be customized so
that the user can add those tasks that are most regularly performed.

Upload: To copy files from your own PC to another computer via a network or using a modem. Opposite of
download.

URL: Uniform Resource Locater - How documents on the WWW are referenced. The URL contains the
protocol to be used e.g. HTTP

Usenet: Usenet news groups are one of the many facilities available on the Internet, that provide a place for
people to post and read discussions on a variety of topics. They are basically a worldwide electronic bulletin
board and are categorized into topics. There are more than 14,000 different topics that can be found on
Usenet. See also News Groups.

User ID: A unique identifier allowing a specific person to have access to a computer or Web site. Some User
IDs are automatically generated by a computer and other systems allow the individual to create his/her own
User ID.

Video Conference: A conference held between a number of people in different geographic locations. Each
has a PC with a video camera attached. Each person is recorded on the camera and the image is played back
on the other participants PC's by a special application program.

Virus: This is a program, which can damage the files on your PC - often created intentionally by hackers to do
just that.

Virus Scan: A process performed by antivirus software, which a PC user will invoke in order to check that her
or his PC contains no known viruses.

WAV: A file type for a sound file, which can be played under windows. When you press the wrong key and the
PC plays back a loud "ping", the operating system is actually running a wav file. Wave files have a file
extension of “wav”.
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Web browser: An application program, which interprets HTML and presents the final web page. Used to "Surf
the World Wide Web". Examples include: Internet Explorer, Netscape Navigator, and Opera.

Webmaster: The person who is responsible for looking after a particular Web Site

Web page: An HTML document, which contains information that can be seen on the Internet.

Website: A group of Web Pages that collectively represent a company, or individual on the World Wide Web.
A group of web pages that have been developed together to present information on specific subjects is also a
Web Site.

Windows 95: A Microsoft operating environment introduced to the world in August 1995.

Windows 98: Microsoft’'s operating environment released to the world in 1998 (hence the name) and very
similar to Windows 95.

WWW: The World Wide Web - The Internet facility that allows you to browse linked web pages.

WYSIWYG: Stands for What You See Is What You Get basically it means that what you can see on the screen
is what you will see on paper when you print the screen contents. Although, the truth of the matter is that
sometimes what you see on the screen is not always what you get when you print. Sometimes frames and
tables cause the information that is on the screen to come out jumbled when printing. The best thing to do
when printing from the Internet is copy the section you wish to print and paste it in a word processing program
such as Microsoft Word, or Word Perfect and then print from that program. At least that way you will be sure
that What You See Is What You Get.

Zip: Zip Files contain vast amounts of information that has undergone compression to reduce the amount of
space that the data take up. This file type is very popular on the Internet. An application that, for example,
requires five megabytes of disk space can be compressed into a two megabyte zip file that is obviously quicker
to download. Two popular Zip programs are PKZIP and WinZip. Both can compress data into a zip file and
extract the contents from a zip file. Zip files have a file extension of “zip”.
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